AVRStudio4 and Atmega128
A Beginner’s Guide

Written By David Zier
Oregon State University
TekBots™
March 30, 2003
# Table of Contents

1 INTRODUCTION
   1.1 PURPOSE ........................................................................................................ 4
   1.2 AVR STUDIO 4 OVERVIEW ........................................................................ 4
   1.3 ATMEGA128 OVERVIEW ........................................................................... 4
   1.4 NOMENCLATURE ........................................................................................ 4
   1.5 DISCLAIMER ................................................................................................. 4

2 AVR STUDIO 4
   2.1 STARTUP TUTORIAL .................................................................................... 5
      2.1.1 Installation ........................................................................................... 5
      2.1.2 Project Creation .................................................................................... 5
      2.1.3 Project Simulation ................................................................................ 7
   2.2 SIMULATION TIPS ....................................................................................... 7
      2.2.1 Line-By-Line Debugging ..................................................................... 8
      2.2.2 Workspace Window ............................................................................. 8
      2.2.3 Memory Windows ................................................................................. 9
   2.3 DEBUGGING STRATEGIES ......................................................................... 10

3 MICROCONTROLLER PROGRAMMING WITH PONYPROG2000 .......... 11
   3.1 INSTALLING PONYPROG2000 .................................................................. 11
   3.2 PONYPROG2000 SETUP ........................................................................... 11
      3.2.1 Setup the AVR Microcontroller Board .............................................. 11
      3.2.2 Setup PonyProg2000 ......................................................................... 12
   3.3 UPLOADING A PROGRAM ......................................................................... 14

4 ATMEGA128 ................................................................................................. 16
   4.1 USEFUL REGISTERS .................................................................................. 16
      4.1.1 General Purpose Registers ................................................................. 16
      4.1.2 Special Function Registers .................................................................. 17
   4.2 INTERRUPT VECTORS ................................................................................ 20
   4.3 MEMORY SPECIFICATIONS ...................................................................... 22
      4.3.1 Program Memory .................................................................................. 22
      4.3.2 SRAM Data Memory ............................................................................ 22
      4.3.3 EEPROM Data Memory ...................................................................... 24
   4.4 STARTER CODE ........................................................................................... 24

5 AVR ASSEMBLY PROGRAMMING ................................................................. 27
   5.1 PRE-COMPIILER DIRECTIVES .................................................................. 27
      5.1.1 CSEG – Code Segment ...................................................................... 28
      5.1.2 DB – Define constant byte(s) ............................................................... 28
      5.1.3 DEF – Set a symbolic name on a register ......................................... 28
      5.1.4 EQU – Set a symbol equal to an expression .................................... 29
      5.1.5 INCLUDE – Include another file ......................................................... 29
      5.1.6 ORG – Set program origin ................................................................ 29
5.2 EXPRESSIONS ................................................................. 30
  5.2.1 Operands ................................................................. 30
  5.2.2 Functions ............................................................... 30
  5.2.3 Operators .............................................................. 30

5.3 BASIC INSTRUCTIONS .................................................. 31
  5.3.1 Common Nomenclature ............................................ 31
  5.3.2 Arithmetic and Logic Instructions ......................... 31
  5.3.3 Branch Instructions ................................................. 32
  5.3.4 Data Transfer Instructions ...................................... 33
  5.3.5 Bit and Bit-test Instructions ................................... 34

5.4 CODING TECHNIQUES ................................................ 36
  5.4.1 Structure .............................................................. 36
  5.4.2 Register Naming .................................................. 38
  5.4.3 Constants and Addressing ...................................... 39
  5.4.4 ATMega128 Definition File .................................... 40

5.5 FLOW OF CONTROL .................................................. 40
  5.5.1 IF Statement ......................................................... 40
  5.5.2 IF-ELSE Statement ............................................... 41
  5.5.3 IF-ELSIF-ELSE Statement ..................................... 42
  5.5.4 WHILE Statement ................................................. 43
  5.5.5 DO Statement ..................................................... 44
  5.5.6 FOR Statement .................................................... 45
  5.5.7 SWITCH Statement ............................................... 46

5.6 FUNCTIONS AND SUBROUTINES ............................... 47
  5.6.1 Definitions .......................................................... 47
  5.6.2 Operational Overview .......................................... 48
  5.6.3 Implementation .................................................. 49

6 REFERENCES .................................................................... 53
1 Introduction

The Department of Electrical and Computer Engineering (ECE) at Oregon State University (OSU) has recently been reevaluating the way classes are taught. With the collaboration of Tektronix, the TekBots program was born. TekBots has allowed ECE a way to educate by keeping a consistent flow in the course work. In keeping with that consistency, ECE 375: Computer Structure and Assembly Language Programming, is in the process of converting labs over to use Atmel’s software tools and AVR RISC core chips. For more information about the TekBots Program, go to http://ece.oregonstate.edu/tekbots/.

1.1 Purpose

The purpose of this document is to provide the reader with the basic knowledge to develop assembly programs for the ATmega128 using AVR Studio 4. The intent of this document is to be used in conjunction with lecture material from ECE 375: Computer Structure and Assembly Language Programming.

1.2 AVR Studio 4 Overview

AVR Studio 4 is the new professional Integrated Development Environment (IDE) for writing and debugging AVR applications in Windows 9x/NT/2000/XP environments. AVR Studio 4 supports the following development tools: ICE50, JTAGICE, ICE200, STK500, and AVRISP. AVR Studio 4 was created by the Atmel Corporation and can be downloaded for free from http://www.atmel.com/atmel/products/prod203.htm.

1.3 ATmega128 Overview

The ATmega128 is a low power CMOS 8-bit microcontroller based on the AVR enhanced RISC architecture. By executing powerful instructions in a single clock cycle, the ATmega128 achieves throughputs approaching 1 MIPS per MHz allowing the system designer to optimize power consumption versus processing speed. The complete datasheet can be downloaded from http://www.atmel.com/atmel/acrobat/doc2467.pdf.

1.4 Nomenclature

Throughout this document, there will be several styles of writing to signify different aspects such as code examples or command line instructions.

- This style is used for normal text
- This style is used for code examples
- This style used for menu selects and commands, ie. File->Exit

1.5 Disclaimer

TekBots and Oregon State University are trademarks of OSU.
AVR Studio 4 and ATmega128 are trademarks and/or copyrighted by Atmel Co.
Windows is a trademark of Microsoft Co.
2 AVR Studio 4

This section provides general information on how to successfully use AVR Studio 4 to complete most, if not all, of the projects. Not every aspect of AVR Studio 4 will be covered here, but for those who choose to learn the program in more detail, additional information can be attained from Atmel’s website at http://www.atmel.com.

2.1 Startup Tutorial

This tutorial will give a step-by-step guide on how to install AVR Studio 4, create a project, and simulate the project. For the purposes of this tutorial, the first lab for ECE 375 will be used. The code can be downloaded from http:// engr.oregonstate.edu/~zier/ECE375/Lab1.asm.

2.1.1 Installation

The installation of AVR Studio 4 is a pretty straightforward process, but nevertheless, here is how to do it.

1. Download astudio4.zip from http://www.atmel.com/atmel/products/prod203.htm. As of this writing, it should be the first link under Development Software on said website.
2. Unzip astudio4.zip into an easily accessible directory such as My Desktop or My Documents.
3. Run the setup program by double left clicking (DLC) on setup.exe.
4. Follow the instructions in the setup program. Most of the default installation directories will work just fine.
5. When finished, click on the Finish button. That’s it; AVR Studio 4 is successfully installed.

2.1.2 Project Creation

AVR Studio 4 is an Integrated Development Environment (IDE). Just like any other IDE, AVR Studio 4 is project based. A project is like an environment for a particular program that is being written. It keeps track of what files are open, compilation instructions, as well as the current Graphical User Interface (GUI) selections. It would be wise to create a separate project and project folder for each and every lab. To demonstrate creating a project, the first lab will be used.

1. Start AVR Studio 4 by clicking through the menus Start->Programs->Atmel AVR Tools->AVR Studio 4. The path could be different if changed during installation.
2. AVR Studio 4 should start up and place a Welcome to AVR Studio 4 dialogue box up. Click on the New Project button in the upper top left. If box does not appear, click on Project->New Project.
3. In the Project Type box, select Atmel AVR Assembler. Future versions will have different project types, but for now, this is the only option available.
4. In the Project Name text box, type the name of the project, such as Lab 1.
5. Normally, both check boxes would be checked to create initial file and create folder, but since we already have the initial file, leave that box unchecked.

6. The **Location** of the project can be changed by clicking on the “…” button next to path name. It is recommended to place the project file in a networked directory (such as ENGR of FLOP) if using a computer on campus or in **My Documents** folder on a personal machine.

7. When finished, the popup dialogue should look like Figure 1: AVR Studio Project Creation.

![Figure 1: AVR Studio Project Creation](image)

8. Click **Next** to continue.

9. The next dialogue asks to **Select Debug Platform and Device**.
   9.1. Select **AVR Simulator** from the **Debug Platform** window.
   9.2. Select **ATmega128** from the **Device** window.

10. Click **Finish** to complete the project creation.

11. Normally, if Create initial File was selected, a blank page would appear to start writing the program on. But, the program is already written, so we must add it to the project.

12. Download the **lab1.asm** file into the newly created project folder.

13. In the **Workspace** window in AVR Studio 4, select the **Project** tab on the bottom left.

14. Open the project tree by clicking on the plus sign next to Lab1. You should now see a folder labeled **Assembler**.

15. **Right Click** on the **Assembler** folder to bring up an option box.

16. Select **Add Existing File** from the option box and an **Open** dialogue should appear.

17. If **lab1.asm** was downloaded correctly, it should be the only file available to choose from. Double left click on **lab1.asm** to open the file.
18. *lab1.asm* should now appear under the **Assembler** folder in the **Workspace** window and the actual program should now appear in the editor area on right.

19. That is it. The project file has now been created.

### 2.1.3 Project Simulation

Now that the project has been created, it needs to be tested. Running the program on a simulated chip built into AVR Studio 4 does this. AVR Studio 4 has the capability to simulate almost every AVR microcontroller offered by Atmel. For the purposes of this tutorial and ECE 375 class, the ATmega128 will be the chip that will be simulated. This chip was selected during the project creation phase. The chip can also be reselected by clicking on **Debug->Select Platform and Device**.

1. Before the program can be simulated, the program must first be compiled. There are three ways to do this:
   1.1. Follow the menu **Project->Build**.
   1.2. Click on the build icon,
   1.3. Or use the F7 key.

2. If the code was successfully compiled, a message in the message box at the bottom should read “Assembly complete with no errors”. If it does not say this, then there were some errors in the code. Clicking on the errors in the message box will highlight the error in the code in the editor window.

3. Once the code has been successfully compiled, simulation can begin. There are two ways to simulate the chip, debugging mode that allows a line-by-line simulation and run mode that continuously runs the program.

3.1. There are a couple of ways to run in debug mode:

   3.1.1. Follow the menu **Debug->Start Debugging**.
   3.1.2. Or click on the Start Debugging Icon.

3.2. To start the run mode:

   3.2.1. Follow the menu **Debug->Run**.
   3.2.2. Click on the Run icon.
   3.2.3. Or use the F5 key.

4. To stop the simulation at any point:

   4.1. Follow the menu **Debug->Stop Debugging**.
   4.2. Or click on the Stop Debugging Icon.

5. That is how to simulate a program. For more detailed simulation tips and strategies, see Simulation Tips.

### 2.2 Simulation Tips

Just simulating a program is not enough. Knowing how to use the simulator and debugger is essential to get results from simulation. This section will provide the necessary information needed to get the most out of a simulation.
2.2.1 Line-By-Line Debugging

Line-by-line debugging is the best way to take control of the simulation. It allows the programmer to verify data in registers and memory. There are several ways to get into line-by-line debugging mode. The first would be to start the simulation in line-by-line debug mode by clicking on the debug icon, or through the menu Debug->Start Debugging. When the program is in run mode, hitting the pause key, will halt the simulation and put it into line-by-line mode. Also, if a break point was set in the code, the simulation will automatically pause at the break point and put the simulation into line-by-line mode.

When running in line-by-line mode, several new buttons will be activated. These allow you to navigate through the program.

- **Step Into (F11)** – Steps into the code. Normal operation will run program line-by-line, but will step into routine calls such as the **RCALL** command.
- **Step Over (F10)** – Steps over routine calls. Normal operation will run program line-by-line, but will treat routine calls as a single instruction and not jump to the routine instructions.
- **Step Out (Shift+F11)** – Steps out of routine calls. This will temporarily put the simulation into run mode for the remainder of the routine and will pause at the next instruction after the routine call.
- **Run to Cursor (Ctrl+F10)** – Runs simulation until cursor is reached. The cursor is the blinking line indicating where to type. Place the cursor by putting the mouse over the instruction you want to stop at and hit the Run to Cursor icon.

After experimenting around with these four commands, you should be able to navigate through the code with ease.

2.2.2 Workspace Window

The workspace window holds valuable information about the project and the simulation. There are three areas of the workspace windows signified by tabs at the bottom; Project, I/O, and Info.

The **Project** window contains all the information related to the project such as files and file structuring. From here, files can be created, destroyed, rearranged, or organized. You can also use this window to select which file appears in the editor window.

The **I/O** window contains all the registers associated with the simulated chip. By default, this window should automatically be displayed when simulation is run in line-by-line mode. Figure 2: I/O Window in Workspace shows an example of what the I/O window looks like during the Lab 1 simulation. By expanding this window, additional information is available such as Bits and Address of the registers. It is in this window where you can simulate input on the ports. The node labeled I/O ATMEGA128 contains all the special registers associated with the chip.
Note: By expanding the I/O ATMEGA128 node, you have access to the ports and can simulate input or interrupts through them.

The **Info** window displays information about the current chip that is being simulated. This information contains names and addresses of registers and external pins. It is a good point of reference when programming for the chip.

### 2.2.3 Memory Windows

In actuality, all of the registers are actually parts of memory within the ATmega128. In addition to the register memory, the ATmega128 has several other memory banks, including the program memory, data memory, and EEPROM memory. Of course, no good simulator is complete without being able to view and/or modify this memory, and AVR Studio 4 is no exception.

To view the memory window, follow the menu command **View->Memory Window** or hit **Alt+4**. The window will pop up on top and can sometimes get in the way. A good way to organize it is to drag the window down next to the message window at the bottom and it will slide in right next to it. Expanding the window will also show additional information. Figure 3: Memory Window shows an example of what it looks like when it is docked next to the message window and expanded.
The main area of the Memory Window contains three sets of information; the address of the line in the blue, the data of the memory in hexadecimal format, and the ASCII equivalent of that data. The pull down menu on the top left allows you to select the various memory banks available for the ATmega128. To edit the memory, just place the cursor in the hexadecimal data area and type in the new data.

2.3 Debugging Strategies

Debugging code can be the most time consuming process in programming. Here are some tips and strategies that can help with this process:

- **Comment, Comment, Comment.** Unless it is absolutely blatantly obvious of what the code is doing, comment EVERY line of code. Even if the code is obvious, at least comment what the group of instruction is doing, for example, “Initializing Stack Pointer”.
- Pick a format and stick with it. The format is how you lay out your code. A single programming format will make reading the code a lot easier.
- Before writing any actual code, write it out in pseudo-code and convince yourself that it works.
- Break the code down into small routines and function calls. Small sections of code are much easier to debug than one huge section of code.
- Wait loops should be commented out during debugging. The simulator is much slower than the actual chip and extensive wait loops take up a lot of time.
- Use breakpoints to halt the simulation at the area known to be buggy. Proper use of breakpoints can save a lot of time and frustration.
- Carefully monitor the I/O Window and Memory Windows throughout the simulation. These windows will indicate any problem.
- Make sure the AVR instruction is actually supported by the ATmega128.
- The ATmega128 has certain memory ranges; so make sure that when manipulating data, the addresses are within range.
3 Microcontroller Programming with PonyProg2000

The primary goal of most AVR assemblers is to use their code on an actual microcontroller. Unfortunately, AVRStudio4 does not provide a way to physically upload the data file onto a microcontroller. Future versions of AVRStudio4 may contain such enhancements, but they will probably rely on Atmel proprietary interface. For now, there is an excellent freeware serial device programmer called PonyProg2000. There are several different flavors of PonyProg, but since this document focuses on the ATmega128, we will use PonyProg2000. This section will contain several step-by-step tutorials on how to use PonyProg. The main site that supports PonyProg2000 can be found at http://www.lancos.com/prog.

3.1 Installing PonyProg2000

This section explains where and how a user would download and install PonyProg2000. This is an ideal section for those who do not already have PonyProg2000 on there system. This program is freeware and will cost you nothing to use, but freeware has its limitations in documentation and support. So far, the author has found no problems with the current version of PonyProg2000.

The following is a step-by-step tutorial on how to download and install the program. This program is designed for Windows machines only.

1. Go to the site http://www.lancos.com/ppwin95.html and click on the link that reads ‘v2.05a BETA’. This will start the download process.
2. Save the downloaded zip file labeled ‘ponyprogV205a.zip’ to an easily accessible folder.
3. Once the zip file has finished downloading, unzip ‘ponyprogV205a.zip’ and extract the ‘setup.exe’ program from the zip file.
4. Run the ‘setup.exe’ program to begin the installation process.
5. Click yes on the dialog box that appears.
6. Follow the steps in the Installation Wizard.
7. The default directories it assigns for the program location and group icons are OK.
8. Once the Installation Wizard is complete, the program is completely installed.

3.2 PonyProg2000 Setup

There are a few things that need to be done with the program before a user can upload data into a microcontroller. This section gives a step-by-step guide on how to setup both PonyProg2000 and the microcontroller board.

3.2.1 Setup the AVR Microcontroller Board

1. Connect the ISP dongal, (A small device that converts parallel data to serial ISP data; for students using the TekBots V3.75 kit, it is the small board with a single
chip on it that came with the kit), to the parallel port on the PC. This should be LPT1 on most systems.

2. Connect one end of the ISP cable, a ribbon cable with a notched 2x5 female connector at either end, to the ISP dongal.

3. Connect the other end of the ISP cable to the ISP port on the AVR microcontroller board; it should be the J22 that is right next to the serial port.

4. Now that the ISP connection is made, apply power to the microcontroller board. NOTE: it is advisable to remove power from the AVR Microcontroller Board any time you plug or unplug the ISP cable.

5. The AVR Microcontroller Board is now connected to the PC and is ready to be programmed.

### 3.2.2 Setup PonyProg2000

1. Make sure the Microcontroller Board is properly connected as stated in Section 3.2.1 and then start up the PonyProg2000 program.

2. Click **OK** to remove the splash screen and get access to the program. Also note, if you are like the author, you might want to check the box labeled “Disable Sound” first.

3. It will then bring up a prompt telling you to calibrate before any read/write operations. Click **OK** to close this dialog.

4. Another prompt asking to run setup will appear, click **OK** to close this as well.

5. The first thing is to select the correct device. There are two pull down menus on the right that do just that. Select “AVR micro” from the first pull down menu and “ATmega128” from the second.

6. Now run the calibration by navigating the menu options, **Setup->Calibration**.

7. Click **YES** on the dialog to begin calibration. It should go very quick. A dialog will then pop and state that the calibration is complete. If you do not get this, then close all the other running applications and try again.

8. Now run the interface setup by navigating the menu options, **Setup->Interface Setup…**

9. A new dialog appears, fill in the information to match the figure below.
10. Click **Probe** to make sure the connection is ok and then click **OK**.

11. With everything setup correctly, you should have a screen that looks similar to the following figure. You have now successfully setup PonyProg2000 for the ATmega128.

![Figure 4: PonyProg2000 Interface Board Setup](image)

![Figure 5: Fully Initialized PonyProg2000](image)
3.3 Uploading a Program

After all the initialization is complete, uploading a program onto the AVR Microcontroller Board is easy. You will, of course, need a program to upload. Here is the step-by-step tutorial on how to do this process.

1. Compile your program in AVRStudio4. This generates a usable AVR program in the form of an HEX file. This is the actual binary data that gets uploaded into the ATmega128.

2. Click on the icon or File->Open Device File… to load a program into PonyProg2000.

3. Navigate to the directory where your AVRStudio4 project is located.

4. Select “*.hex” from the pull down menu labeled “Files of type:”.

5. A file should appear that has the same name of your project in the AVRStudio4. Click on this name and then click Open to load the program.

6. A successfully loaded program should look similar to the following figure.

![Figure 6: Successfully Loaded AVR Hex Program File in PonyProg2000](image)

7. Finally, upload the program onto the ATmega128 by clicking on the icon or by the menu, Command->Write All. Also, Ctrl-W will work. This should bring
up a dialog that confirms your request to program the device. Click **Yes** to begin upload.

8. A progress bar will appear. It will write to the device, and verify it twice. This takes about a minute or two to complete. When it is finish, a dialog appears telling that it was successful or not. Click on **OK** to go back to PonyProg2000.

9. Once the program has been written to the ATmega128, the ATmega128 will automatically reset and start running your program. Congratulations, you have now successfully uploaded your program

During any stage of development, the program is not generally perfect from the start. Several revisions must be made and a lot of debugging. This generally means that a program will have to be downloaded several times into the chip. Well, you do not have to reload the program each time you make changes; there is a nice little function that does this for us. First, keep both AVRStudio4 and PonyProg2000 open. Make you change in AVRStudio4 and then recompile your program (F7). Now, switch over to PonyProg2000, it should still have the last version of the program loaded.

Click the ![icon] icon to refresh the code. Doing so will automatically update the loaded program file in the window to reflect any changes made. Finally, just upload the program again. This is really a time saver and you will use it a lot during the development of projects.

Feel free to explore the rest that PonyProg2000 has to offer. This document only covers the basics and does not go into any more detail about PonyProg2000. There is one more mention though, be careful of any modification to the fuse bits as they can several alter the way the ATmega128 functions.
4 ATmega128

This section will provide some basic information about the ATmega128. For more detailed information about the ATmega128, see the Complete Datasheet at http://www.atmel.com/atmel/acrobat/doc2467.pdf.

4.1 Useful Registers

The ATmega128 is equipped with two types of registers, general purpose registers and special function registers. All the registers in the ATmega128 are 8-bit, which means they are basically just 8 flip-flops in a row and are, in actuality, just part of the memory, each with their own address. Unlike other areas of memory that are tied into a multiplexor, registers are tied directly to the CPU and hold valuable data for the CPU.

4.1.1 General Purpose Registers

There are 32 General Purpose Registers in the ATmega128. These registers are connected to the ALU (Arithmetic Logic Unit) and are used to manipulate data. The registers are labeled R0 – R31.

4.1.1.1 Lower Registers

The lower 16 registers, R0 – R15, work just the rest of the registers with the exception of loading immediate data. These registers have access to the full range of the Data Memory, ALU, and additional peripherals. Here is an example of using the loading immediate data into the lower registers:

```
LDI R16, 30 ; Load the number 30 into R16
MOV R0, R16 ; Copy R16 into R0, R0 <- R16
INC R0 ; Increment R0, R0 <- R0+1
ADD R0, R16 ; R0 <- R0 + R16, value in R0 should now be 61
```

4.1.1.2 Upper Registers

The upper 16 registers, R16 – R31, have additional capabilities. They have access to immediate data using the LDI instruction. These registers will be the ones that get the most use throughout your program. To move data into or out of these registers, the various different Load and Store instructions are needed. All arithmetic instructions work on these registers. Here is an example of using the upper registers:

```
LDI R16, $A4 ; Load the immediate hex value into R16
LD R17, X ; Load value from memory address in X-Pointer
ADC R16, R17 ; Add with carry, R16 <- R16 + R17 + Carry Bit
ST Y, R16 ; Store value in R16 to address in Y-Pointer
```
4.1.1.3 X-, Y-, Z-Registers

The last six of the General Purpose Registers have additional functionality. They serve as the pointers for indirect addressing. The ATmega128 has a 16-bit addressing scheme that requires two registers for the address alone. The AVR RISC structure supports this scheme with the X, Y, and Z-Registers. These registers are the last six General Purpose Registers (R26-R31). The following table details the register assignments:

<table>
<thead>
<tr>
<th>Name</th>
<th>Byte</th>
<th>Assignment</th>
</tr>
</thead>
<tbody>
<tr>
<td>X-Register</td>
<td>Low</td>
<td>R26</td>
</tr>
<tr>
<td></td>
<td>High</td>
<td>R27</td>
</tr>
<tr>
<td>Y-Register</td>
<td>Low</td>
<td>R28</td>
</tr>
<tr>
<td></td>
<td>High</td>
<td>R29</td>
</tr>
<tr>
<td>Z-Register</td>
<td>Low</td>
<td>R30</td>
</tr>
<tr>
<td></td>
<td>High</td>
<td>R31</td>
</tr>
</tbody>
</table>

The following code is an example of how to use these special registers. The code will read a value from SRAM, manipulate it, and then store it back at the next address in SRAM.

```
LDI    R26, $5A ; Load 0x5A into the low Byte of X
LDI    R27, $02 ; Load 0x02 into the high Byte of X
LD     R16, X+ ; Load value from SRAM, increment X
INC    R16  ; Manipulate value
ST     X, R16 ; Store value to SRAM
```

4.1.2 Special Function Registers

Special Function Registers are registers in the ATmega128 that either control or monitor the various components of the chip. In this section, I will cover the commonly used Special Function Registers. Most of the Special Function Registers have read/write capabilities, check the datasheet for the ATmega128 for more details. These register reside in the ATmega128 I/O Memory and as such, require the IN and OUT instructions to read and write to these registers.

4.1.2.1 Status Register (SREG)

The Status Register or SREG contains the important information about the ALU such as the Carry Bit, Overflow Bit, and Zero Bit. These bits are set and cleared during ALU instructions. This register becomes extremely useful during branching operations. The following table details the bit assignments within the SREG.
Table 2: SREG Definition

<table>
<thead>
<tr>
<th>Bit</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>I</td>
<td>Global Interrupt Enable</td>
</tr>
<tr>
<td>6</td>
<td>T</td>
<td>Bit Copy Storage</td>
</tr>
<tr>
<td>5</td>
<td>H</td>
<td>Half Carry Flag</td>
</tr>
<tr>
<td>4</td>
<td>S</td>
<td>Sign Bit</td>
</tr>
<tr>
<td>3</td>
<td>V</td>
<td>Twos Compliment Overflow Flag</td>
</tr>
<tr>
<td>2</td>
<td>N</td>
<td>Negative Flag</td>
</tr>
<tr>
<td>1</td>
<td>Z</td>
<td>Zero Flag</td>
</tr>
<tr>
<td>0</td>
<td>C</td>
<td>Carry Flag</td>
</tr>
</tbody>
</table>

As an example of using this register, look at the **BREQ** or Branch If Equal instruction. When this instruction is called, it looks at the Zero Flag in the SREG. If the Zero Flag is set, then the instruction will branch to the program address specified, otherwise it will continue on as usual.

### 4.1.2.2 Stack Pointer

The Stack is mainly used for storing temporary data, for storing local variables and for storing return addresses after interrupts and subroutine calls. The Stack Pointer Register always points to the top of the Stack. Note that the Stack is implemented as growing from higher memory locations to lower memory locations. This implies that a Stack **PUSH** command decreases the Stack Pointer.

The AVR Stack Pointer is implemented as two 8-bit Special Function Registers, Stack Pointer High Register (SPH) and Stack Pointer Low Register (SPL). The following diagram is a representation of the Stack Pointer.

![Figure 7: Stack Pointer](image)

The following example demonstrates how to initialize the Stack Pointer. Remember to include the definition file for the ATmega128 at the beginning of the program to utilize Register naming schemes.

```assembly
.include "ml28def.inc"  ; Include definition file in program

LDI R16, LOW(RAMEND)   ; Low Byte of End SRAM Address
OUT SPL, R16          ; Write byte to SPL
LDI R16, HIGH(RAMEND) ; High Byte of End SRAM Address
OUT SPH, R16          ; Write byte to SPH
```
4.1.2.3 I/O Ports

The ATmega128 is equipped with 7 I/O Ports labeled Port A through Port G. Each port has its own unique capabilities such as External RAM Addressing, PWMs, Timers, and Counters. Unfortunately, this document will only cover the basics that are common with each port. For more detail information, refer to the Complete Datasheet for the ATmega128.

The I/O Port is the most fundamental way to move data in to or out of the ATmega128. The ports are bi-directional I/O ports with optional internal pull-ups. Throughout the rest of the description, certain names are abbreviated that are common to all registers. For example, a generic pin on an I/O port is referred to as Pxn, where x is the port name (A-G) and n is the pin number (0-7).

Each port pin consists of three Register bits: DDxn, PORTxn, and PINxn. The DDxn bits are accessed at the the DDRx Special Function Register (SFR), the PORTxn bits at the PORTx SFR, and the PINxn bits at the PINx SFR. To alleviate confusion, these three Special Function Registers for Port A are detailed below.

![Figure 8: Port A Data Register – PORTA](image)

<table>
<thead>
<tr>
<th>Bit</th>
<th>7</th>
<th>6</th>
<th>5</th>
<th>4</th>
<th>3</th>
<th>2</th>
<th>1</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>PortA7</td>
<td>PORTA6</td>
<td>PORTA5</td>
<td>PORTA4</td>
<td>PORTA3</td>
<td>PORTA2</td>
<td>PORTA1</td>
<td>PORTA0</td>
<td></td>
</tr>
<tr>
<td>Read/Write</td>
<td>R/W</td>
<td>R/W</td>
<td>R/W</td>
<td>R/W</td>
<td>R/W</td>
<td>R/W</td>
<td>R/W</td>
<td></td>
</tr>
<tr>
<td>Initial Value</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>

![Figure 9: Port A Data Direction Register – DDRA](image)

<table>
<thead>
<tr>
<th>Bit</th>
<th>7</th>
<th>6</th>
<th>5</th>
<th>4</th>
<th>3</th>
<th>2</th>
<th>1</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>DDA7</td>
<td>DDA6</td>
<td>DDA5</td>
<td>DDA4</td>
<td>DDA3</td>
<td>DDA2</td>
<td>DDA1</td>
<td>DDA0</td>
<td></td>
</tr>
<tr>
<td>Read/Write</td>
<td>R/W</td>
<td>R/W</td>
<td>R/W</td>
<td>R/W</td>
<td>R/W</td>
<td>R/W</td>
<td>R/W</td>
<td></td>
</tr>
<tr>
<td>Initial Value</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>

![Figure 10: Port A Input Pins Address – PINA](image)

<table>
<thead>
<tr>
<th>Bit</th>
<th>7</th>
<th>6</th>
<th>5</th>
<th>4</th>
<th>3</th>
<th>2</th>
<th>1</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>PINA7</td>
<td>PINA6</td>
<td>PINA5</td>
<td>PINA4</td>
<td>PINA3</td>
<td>PINA2</td>
<td>PINA1</td>
<td>PINA0</td>
<td></td>
</tr>
<tr>
<td>Read/Write</td>
<td>R/W</td>
<td>R/W</td>
<td>R/W</td>
<td>R/W</td>
<td>R/W</td>
<td>R/W</td>
<td>R/W</td>
<td></td>
</tr>
<tr>
<td>Initial Value</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td></td>
</tr>
</tbody>
</table>

The DDxn bit in the DDRx Register selects the direction of this pin. If DDxn is written logic one, Pxn is configured as an output pin. If DDxn is written logic zero, Pxn is configured as an input pin.

If PORTxn is written logic one when the pin is configured as an input pin, the pull-up resistor is activated. To switch the pull-up resistor off, PORTxn has to be written logic zero or the pin has to be configured as an output pin.
If PORTxn is written logic one when the pin is configured as an output pin, the port pin is driven high (one). If PORTxn is written logic zero when the pin is configured as an output pin, the port pin is driven low (zero).

Table 3 summarizes the control signals for the pin value.

<table>
<thead>
<tr>
<th>DDxn</th>
<th>PORTxn</th>
<th>PUD (in SFIOR)</th>
<th>I/O</th>
<th>Pull-up</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>X</td>
<td>Input</td>
<td>No</td>
<td>Tri-state (Hi-Z)</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>0</td>
<td>Input</td>
<td>Yes</td>
<td>Pxn will source current if ext. pulled low.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>1</td>
<td>Input</td>
<td>No</td>
<td>Tri-state (Hi-Z)</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>X</td>
<td>Output</td>
<td>No</td>
<td>Output Low (Sink)</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>X</td>
<td>Output</td>
<td>No</td>
<td>Output High (Source)</td>
</tr>
</tbody>
</table>

Note: When reading a value from the port, read from the PINx Register. When writing a value to the port, write to the PORTx register.

The following code is an example of how to initialize the ports. This example initializes Port B as output and Port D as input. Remember, this code uses the definition document that is included somewhere in the beginning of the program.

```
LDI R16, $FF ; Select Direction as Output on all pins
OUT DDRB, R16 ; Set value in DDRB
LDI R16, $FF ; Set Initial value to high on all pins
OUT PORTB, R16 ; Set PORTB value, Port B pins should be high

LDI R16, $00 ; Select Direction as Input on all pins
OUT DDRD, R16 ; Set value in DDRD
LDI R16, $00 ; Use normal Tri-state with no Pull-up register
OUT PORTD, R16 ; Port D is now ready as input
```

4.1.2.4 Additional Special Function Registers

Details on other Special Function Registers can be obtained from the complete datasheet for the ATmega128. Future version of this document might discuss other registers if needed for the ECE 375 class.

4.2 Interrupt Vectors

Interrupts are special functions that are automatically called when trigger in the hardware of the ATmega128. In general, interrupts are enabled or disabled through the Global Interrupt Enable, bit 7 of the SREG. There are some AVR Assembly instructions that do this as well, **SEI**, Set Global Interrupt, and **CLI**, Clear Global Interrupt. Of course, just turning the Global Interrupt Enable on and off won’t activate the interrupts themselves.
Each interrupt has a specific enable bit in the Special Function Register. To find out how to enable a specific interrupt, refer to the complete datasheet for the ATmega128.

Once an interrupt is triggered, the current instruction address is saved to the stack and the program address is sent to that specific Interrupt Vector. An Interrupt Vector is a specific address in the program memory associated with the interrupt. There is general enough room at the Interrupt Vector to make a call to the interrupt function somewhere else in program memory and a return from interrupt instruction.

The following table is a list of all the Interrupt Vectors, as well as there addresses in program memory, and definitions.

<table>
<thead>
<tr>
<th>Vector No.</th>
<th>Program Address</th>
<th>Source</th>
<th>Interrupt Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>$0000</td>
<td>RESET</td>
<td>External Pin, Power-on Reset, Brown-out Reset, Watchdog Reset, and JTAG AVR Reset</td>
</tr>
<tr>
<td>2</td>
<td>$0002</td>
<td>INT0</td>
<td>External Interrupt Request 0</td>
</tr>
<tr>
<td>3</td>
<td>$0004</td>
<td>INT1</td>
<td>External Interrupt Request 1</td>
</tr>
<tr>
<td>4</td>
<td>$0006</td>
<td>INT2</td>
<td>External Interrupt Request 2</td>
</tr>
<tr>
<td>5</td>
<td>$0008</td>
<td>INT3</td>
<td>External Interrupt Request 3</td>
</tr>
<tr>
<td>6</td>
<td>$000A</td>
<td>INT4</td>
<td>External Interrupt Request 4</td>
</tr>
<tr>
<td>7</td>
<td>$000C</td>
<td>INT5</td>
<td>External Interrupt Request 5</td>
</tr>
<tr>
<td>8</td>
<td>$000E</td>
<td>INT6</td>
<td>External Interrupt Request 6</td>
</tr>
<tr>
<td>9</td>
<td>$0010</td>
<td>INT7</td>
<td>External Interrupt Request 7</td>
</tr>
<tr>
<td>10</td>
<td>$0012</td>
<td>TIMER2 COMP</td>
<td>Timer/Counter2 Compare Match</td>
</tr>
<tr>
<td>11</td>
<td>$0014</td>
<td>TIMER2 COMPA</td>
<td>Timer/Counter2 Compare Match A</td>
</tr>
<tr>
<td>12</td>
<td>$0016</td>
<td>TIMER2 COMPC</td>
<td>Timer/Counter2 Compare Match C</td>
</tr>
<tr>
<td>13</td>
<td>$0018</td>
<td>TIMER1 CAPT</td>
<td>Timer/Counter1 Capture Event</td>
</tr>
<tr>
<td>14</td>
<td>$001A</td>
<td>TIMER1 COMPA</td>
<td>Timer/Counter1 Compare Match A</td>
</tr>
<tr>
<td>15</td>
<td>$001C</td>
<td>TIMER1 COMPB</td>
<td>Timer/Counter1 Compare Match B</td>
</tr>
<tr>
<td>16</td>
<td>$001E</td>
<td>TIMER0 COMP</td>
<td>Timer/Counter0 Compare Match</td>
</tr>
<tr>
<td>17</td>
<td>$0020</td>
<td>TIMERO OVF</td>
<td>Timer/Counter0 Compare Match</td>
</tr>
<tr>
<td>18</td>
<td>$0022</td>
<td>SPI, STC</td>
<td>SPI Serial Transfer Complete</td>
</tr>
<tr>
<td>19</td>
<td>$0024</td>
<td>USART0, RX</td>
<td>USART0, Rx Complete</td>
</tr>
<tr>
<td>20</td>
<td>$0026</td>
<td>USART0, UDRE</td>
<td>USART0 Data Register Empty</td>
</tr>
<tr>
<td>21</td>
<td>$0028</td>
<td>USART0, TX</td>
<td>USART0, Tx Complete</td>
</tr>
<tr>
<td>22</td>
<td>$002A</td>
<td>ADC</td>
<td>ADC Conversion Complete</td>
</tr>
<tr>
<td>23</td>
<td>$002C</td>
<td>EE READY</td>
<td>EEPROM Ready</td>
</tr>
<tr>
<td>24</td>
<td>$002E</td>
<td>ANALOG COMP</td>
<td>Analog Comparator</td>
</tr>
<tr>
<td>25</td>
<td>$0030</td>
<td>TIMER1 COMPC</td>
<td>Timer/Counter1 Compare Match C</td>
</tr>
<tr>
<td>26</td>
<td>$0032</td>
<td>TIMER3 CAPT</td>
<td>Timer/Counter3 Capture Event</td>
</tr>
<tr>
<td>27</td>
<td>$0034</td>
<td>TIMER3 COMPA</td>
<td>Timer/Counter3 Compare Match A</td>
</tr>
<tr>
<td>28</td>
<td>$0036</td>
<td>TIMER3 COMPB</td>
<td>Timer/Counter3 Compare Match B</td>
</tr>
<tr>
<td>29</td>
<td>$0038</td>
<td>TIMER3 COMPC</td>
<td>Timer/Counter3 Compare Match C</td>
</tr>
<tr>
<td>30</td>
<td>$003A</td>
<td>TIMER3 OVF</td>
<td>Timer/Counter3 Overflow</td>
</tr>
<tr>
<td>31</td>
<td>$003C</td>
<td>USART1, RX</td>
<td>USART1, Rx Complete</td>
</tr>
<tr>
<td>32</td>
<td>$003E</td>
<td>USART1, UDRE</td>
<td>USART1 Data Register Empty</td>
</tr>
<tr>
<td>33</td>
<td>$0040</td>
<td>USART1, TX</td>
<td>USART1, Tx Complete</td>
</tr>
<tr>
<td>34</td>
<td>$0042</td>
<td>TWI</td>
<td>Two-wire Serial Interface</td>
</tr>
<tr>
<td>35</td>
<td>$0044</td>
<td>SPM READY</td>
<td>Store Program Memory Ready</td>
</tr>
</tbody>
</table>
See Section 4.4 Starter Code to find out how to code the Interrupt Vector.

### 4.3 Memory Specifications

This section describes the different memories in the ATmega128. The AVR architecture has two main memory spaces, the Data Memory and the Program Memory space. In addition, the ATmega128 features an EEPROM Memory for data storage. All three memory spaces are linear and regular.

#### 4.3.1 Program Memory

The Atmega128 contains 128K bytes of On-chip In-System Reprogrammable Flash memory for program storage. Since all AVR instructions are 16 or 32 bits wide, the Flash is organized as 64K x 16. For software security, the Flash Program memory space is divided into two sections, Boot Program section and Application Program section. The figure below illustrates the Flash Memory.

![Program Memory Map](image)

Constant tables can be allocated within the entire program memory address space. To access these constant, or any data within the program memory, use the AVR instructions **LPM** – Load Program Memory or **ELPM** – Extended Load Program Memory. Refer to the instruction description in the AVR Instruction Set document to learn how to use them.

#### 4.3.2 SRAM Data Memory

The ATmega128 supports two different configurations for the SRAM data memory, Normal mode and ATmega103 Compatibility mode. This mode is selected in the fuse bits of the ATmega128. For the purposes of this class and document, only the Normal
mode will be discussed and used. The following figure illustrates the memory map for the SRAM.

![Data Memory Map](image)

The ATmega128 is a complex microcontroller with more peripheral units than can be supported within the 64-byte location reserved in the Opcode for \texttt{IN} and \texttt{OUT} instructions. For the Extended I/O space from $60 - $FF in SRAM, only the \texttt{ST/STS/STD} and \texttt{LD/LDS/LDD} instructions can be used.

The first 4352 Data Memory locations address the Register file, the I/O Memory and the internal data SRAM. The first 32 locations address the Register file, the next 64 locations address the standard I/O memory, 160 locations of Extended I/O memory, and then the next 4096 locations address the internal data SRAM.

An optional external data SRAM can be used with the ATmega128. Refer to the datasheet for information on how to accomplish this.

The five different addressing modes for the data memory cover: Direct, Indirect with Displacement, Indirect, Indirect with Pre-decrement, Indirect with Post-increment. In the General Purpose Register file, registers R26 to R31 feature the indirect addressing pointer registers (X, Y, Z). See the section on X-, Y-, Z-Registers for more information about these registers.

The direct addressing reaches the entire data space.
The Indirect with Displacement mode reaches 63 address locations from the base address given by the Y- or Z-register.

When using register indirect addressing modes with automatic pre-decrement and post-decrement, the address registers X, Y, and Z are decremented or incremented.

### 4.3.3 EEPROM Data Memory

The ATmega128 contains 4K bytes of data EEPROM memory. The EEPROM memory is useful in certain applications where modifying the data in the field becomes important. For the purposes of the class and this document, the EEPROM is not discussed in detail. For information on the EEPROM, refer to the datasheet for the ATmega128.

### 4.4 Starter Code

This section is an AVR program that can be used as a good starting point for any program. Just copy the program directly into a new project. The code shows a good coding technique as well as leaves areas for the interrupt vectors. It also gives some of the basic initialization routines.

```assembly
;**************************************************************
;* Project Name Here
; * Project Description Here
;**************************************************************
;* Author:  Your Name
;* Lab:  Lab Number Here
;* Date:  Enter the date Here
;**************************************************************
.include "m128def.inc" ; Definition file for ATmega128

;**************************************************************
;* Program Constants
;**************************************************************
.equ const =$00 ; Generic Constant Structure

;**************************************************************
;* Program Variables Definitions
;**************************************************************
.def mpr =r16 ; Multipurpose Register

;**************************************************************
;* Interrupt Vectors
;**************************************************************
.cseg
.org $0000 ; Define start of Code segment
.rjmp RESET ; Reset Handler
```
reti   ; IRQ0 Handler
nop
reti   ; IRQ1 Handler
nop
reti   ; Timer2 Compare Handler
nop
reti   ; Timer2 Overflow Handler
nop
reti   ; Timer1 Capture Handler
nop
reti   ; Timer1 CompareA Handler
nop
reti   ; Timer1 CompareB Handler
nop
reti   ; Timer1 Overflow Handler
nop
reti   ; Timer0 Overflow Handler
nop
reti   ; SPI Transfer Complete Handler
nop
reti   ; USART RX Complete Handler
nop
reti   ; UDR Empty Handler
nop
reti   ; USART TX Complete Handler
nop
reti   ; ADC Conversion Complete Handler
nop
reti   ; EEPROM Ready Handler
nop
reti   ; Analog Comparator Handler
nop
reti   ; Two-wire Serial Interface Handler
nop
reti   ; Store Program Memory Ready Handler
nop

;***************************************************************
;* Func: RESET
;* Desc: Reset Handler Routine
;***************************************************************
RESET:
    ; ***** Stack Pointer Init *****
    ldi  mpr, LOW(RAMEND)
    out  SPL, mpr
    ldi  mpr, HIGH(RAMEND)
    out  SPH, mpr
    rjmp  MAIN

;***************************************************************
;* Func: MAIN
;* Desc: Main Entry into program
;***************************************************************
MAIN:
    ;< Insert your program Here>
    rjmp  MAIN          ; Loop Indefinitely
To use the Interrupt Vector, create the Interrupt Handler Routine similar to the RESET routine. Then replace the NOP instruction for the interrupt and replace it with an RJMP command to the newly created Interrupt Handler Routine.
5 AVR Assembly Programming

This section concentrates on the usage of the AVR Instruction Set. This guide will not cover every single Instruction or all the Assembler Directives. Instead, it will cover the most basic and commonly used instructions and directives and give techniques on how to use them efficiently to get the most out of your program. For a detailed list of instructions, refer to the Atmel’s AVR Instruction Set. It can be found at http://www.atmel.com/atmel/acrobat/doc0856.pdf. For a complete detailed list of all the AVR Assembler Directives, refer to Section 4.5 of AVR Assembler. It can be found at http://www.atmel.com/atmel/acrobat/doc1022.pdf.

5.1 Pre-compiler Directives

Pre-compiler directives are special instructions that are executed before the code is compiled and directs the compiler. These instructions are denoted by the preceding dot, i.e. .EQU. The directives are not translated directly into opcodes. Instead, they are used to adjust the location of the program in memory, define macros, initialize memory, and so on. The following sections will contain detailed information on the most commonly used directives. The following table contains an overview of the directives supported by the AVR Assembler.

<table>
<thead>
<tr>
<th>Directive</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>.BYTE</td>
<td>Reserve byte to a variable</td>
</tr>
<tr>
<td>.CSEG</td>
<td>Code Segment</td>
</tr>
<tr>
<td>.DB</td>
<td>Define constant byte(s)</td>
</tr>
<tr>
<td>.DEF</td>
<td>Define a symbolic name on a register</td>
</tr>
<tr>
<td>.DEVICE</td>
<td>Define which device to assemble for</td>
</tr>
<tr>
<td>.DSEG</td>
<td>Data Segment</td>
</tr>
<tr>
<td>.DW</td>
<td>Define constant words</td>
</tr>
<tr>
<td>.ENDMACRO</td>
<td>End macro</td>
</tr>
<tr>
<td>.EQU</td>
<td>Set a symbol equal to an expression</td>
</tr>
<tr>
<td>.ESEG</td>
<td>EEPROM segment</td>
</tr>
<tr>
<td>.EXIT</td>
<td>Exit from a file</td>
</tr>
<tr>
<td>.INCLUDE</td>
<td>Read source from another file</td>
</tr>
<tr>
<td>.LIST</td>
<td>Turn listfile generation on</td>
</tr>
<tr>
<td>.LISTMAC</td>
<td>Turn macro expression on</td>
</tr>
<tr>
<td>.MACRO</td>
<td>Begin Macro</td>
</tr>
<tr>
<td>.NOLIST</td>
<td>Turn listfile generation off</td>
</tr>
<tr>
<td>.ORG</td>
<td>Set program origin</td>
</tr>
<tr>
<td>.SET</td>
<td>Set a symbol to an expression</td>
</tr>
</tbody>
</table>
### 5.1.1 CSEG – Code Segment

The CSEG directive defines the start of a Code Segment. An assembler file can contain multiple Code Segments, which are concatenated into one Code Segment when assembled. The directive does not take any parameters.

**Syntax:**
```
.CSEG
```

**Example:**
```
.DSEG    ; Start Data Segment
    vartab: .BYTE 4 ; Reserve 4 bytes in SRAM
.CSEG
    const: .DW 2 ; Write 0x0002 in program memory
    mov  r1, r0 ; Do something
```

### 5.1.2 DB – Define constant byte(s)

The DB directive reserves memory resources in the program memory or the EEPROM memory. In order to be able to refer to the reserved locations, a label should precede the DB directive.

The DB directive takes a list of expressions, and must contain at least one expression. The list of expressions is a sequence of expressions, delimited by commas. Each expression must evaluate to a number between –128 and 255 since each expression is represented by 8-bits. A negative number will be represented by the 8-bits two’s complement of the number.

If the DB directive is used in a Code Segment and the expression list contains more than one expression, the expressions are packed so that two bytes are placed in each program memory word. If the expression list contains an odd number of expressions, the last expression will be placed in a program memory word of its own, even if the next line in the assembly code contains a DB directive.

**Syntax:**
```
LABEL:  .DB expressionlist
```

**Example:**
```
.CSEG
    consts:
        .DB 0, 255, 0b01010101, -128, $AA
    text:
        .DB “Hello World”
```

### 5.1.3 DEF – Set a symbolic name on a register

The DEF directive allows the registers to be referred to through symbols. A defined symbol can be used to the rest of the program to refer to the registers it is assigned to. A register can have several symbolic names attached to it. A symbol can be redefined later in the program.

**Syntax:**
```
.DEF Symbol = Register
```
Example:
.DEF temp = R16
.DEF ior = R0
.CSEG
  ldi temp, $F0 ; Load 0xF0 into temp register
  in ior, $3f ; Read SREG into ior register
  eor temp, ior ; Exclusive or temp and ior

5.1.4 EQU – Set a symbol equal to an expression

The EQU directive assigns a value to a label. This label can then be used in later expressions. A label assigned to a value by the EQU directive is a constant and can not be changed or redefined.

Syntax:
.DEF label = expression

Example:
.EQU io_offset = $23
.EQU porta = io_offset + 2
.CSEG
  clr r2 ; Clear register 2
  out porta, r2 ; Write to Port A

5.1.5 INCLUDE – Include another file

The INCLUDE directive tells the Assembler to start reading from a specified file. The Assembler then assembles the specified file until the end of file (EOF) or an EXIT directive is encountered. An include file may itself contain INCLUDE directives.

Syntax:
.INCLUDE “filename”

Example:
.DEF sreg = $3F ; Status register
.DEF sphigh = $3E ; Stack pointer high
.DEF splow = $3D ; Stack pointer low
.INCLUDE “iodefs.asm” ; Include I/O definitions
.in r0, sreg ; Read status register

5.1.6 ORG – Set program origin

The ORG directive sets the location counter to an absolute value. The value to set is given as a parameter. If an ORG directive is given within a Code Segment, then it is the Program memory counter that is set. If the directive is preceded by a label (on the same source line), the label will be given the value of the parameter. The default value of the Code location counter is zero when assembling is started. Note that the Program memory location counter counts words and not bytes.

Syntax:
.ORG expression

Example:

```
.CSEG
    rjmp main  ; Jump to the main section of code
.ORG $0042   ; Set location counter to address $0042 to skip the
            ; interrupt vectors
main:
    ; Main section of code
    mov r0, r1  ; Do something
```

## 5.2 Expressions

The Assembler incorporates expressions. Expressions can consist of operands, operators and functions. All expressions are internally 32 bits.

### 5.2.1 Operands

The following operands can be used:

- User defined labels that are given the value of the location counter at the place they appear.
- User defined constants defined by the EQU directive.
- Integer constants: constants can be given in several formats, including
  - Decimal (default): 10, 255
  - Hexadecimal (two notations): 0x0a, $0a, 0xff, $ff
  - Binary: 0b00001010, 0b11111111
- PC – the current value of the Program memory location counter

### 5.2.2 Functions

The following functions are defined:

- LOW(expression) returns the low byte of an expression
- HIGH(expression) returns the high byte of an expression
- BYTE2(expression) is the same function as HIGH
- BYTE3(expression) returns the third byte of an expression
- BYTE4(expression) returns the fourth byte of an expression
- LWRD(expression) returns bits 0-15 of an expression
- HWRD(expression) returns bits 16-31 of an expression
- PAGE(expression) returns bites 16-21 of an expression
- EXP2(expression) returns $2^{expression}$
- LOG2(expression) returns the integer part of log2(expression)

### 5.2.3 Operators

The Assembler supports a number of operators that are described in section 4.6.3 of the *AVR Assembler* document. These operators can be commonly associated with C/C++ operators. Note that these operations are done only during compilation and cannot be used in place of the AVR Instructions.
### 5.3 Basic Instructions

Almost all AVR Instructions fall into three categories; Arithmetic and Logic Instructions, Branch Instructions, and Data Transfer Instructions. This section will not cover every instruction in the AVR Instruction Set; instead, it will support the *AVR Instruction Set* document by expanding on key instructions and their uses.

#### 5.3.1 Common Nomenclature

With the exception of a few instructions, all AVR Assembly Instructions follow a common nomenclature. There are three parts to every instruction, the Instruction Name, Argument 1, and Argument 2.

Every AVR Instruction has an instruction name. This name is a unique three or four letter combination that identifies the instruction; for example, the AVR Instruction the Loads an Immediate Value has the Instruction Name of **LDI**.

Also, every instruction may have up to two arguments associated with it. These arguments follow the Instruction Name and are separated by a comma. When arguments are used, it is important to note that the result of the command will always be stored in the first argument. Please note the figure below.

![Table of Instruction Nomenclature](image)

#### 5.3.2 Arithmetic and Logic Instructions

The arithmetic and logic instructions make use of the microcontroller’s ALU. Almost all of the arithmetic and logic instructions consist of a two arguments and can modify all of the status bits in the SREG. Take note that all of the arithmetic and logic instructions are 8-bit only. The following is a breakdown of the available instructions:

- Addition: **ADD**, **ADC**, **ADIW**
- Subtraction: **SUB**, **SUBL**, **SBC**, **SBCI**, **SBW**
- Logic: **AND**, **ANDI**, **OR**, **ORI**, **EOR**
- Compliments: **COM**, **NEG**
- Register Bit Manipulation: **SBR**, **SBR**
- Register Manipulation: **INC**, **DEC**, **TST**, **CLR**, **SER**
- Multiplication:\(^1\) **MUL**, **MULS**, **MULSU**
- Fractional Multiplication:\(^1\) **FMUL**, **FMULS**, **FMULSU**

\(^1\) Multiplication and Division is very limited and restrictive
There is a common nomenclature to the naming of the instructions. The following table explains the nomenclature.

<table>
<thead>
<tr>
<th>Ending Letter</th>
<th>Meaning</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
<td>Carry</td>
<td>Operation will involve the carry bit</td>
</tr>
<tr>
<td>I</td>
<td>Immediate</td>
<td>Operation involves an immediate value that is passed as the second argument.</td>
</tr>
<tr>
<td>W</td>
<td>Word</td>
<td>The operation is a 16-bit operation.</td>
</tr>
<tr>
<td>S</td>
<td>Signed</td>
<td>The operation handles signed numbers</td>
</tr>
</tbody>
</table>
| SU            | Signed/Unsigned | The operation handles both signed and unsigned. |}

### 5.3.3 Branch Instructions

Branch Instructions are used to introduce logical decisions and flow of control within a program. About 20% of any program consists of branches. A branch instruction is basically an instruction that can modify the Program Counter (PC) and redirect where the next instruction is fetched. There are two types of branch instructions, unconditional branches and conditional branches.

#### 5.3.3.1 Unconditional Branches

Unconditional branches modify the PC directly. These instructions are known as jumps because they cause the program to “jump” to another location in program memory. There are several types of jump instructions (RJMP, IJMP, EIJMP, JMP), but the most common one is the relative jump, RJMP, because it takes the least amount of cycles to perform and can access the entire memory array.

There are also special unconditional branch instructions known as function calls, or calls (RCALL, ICALL, EICALL, CALL). The function calls work just like the jump instructions, except they also push the next address of the PC on to the stack before making the jump. There is also a corresponding return instruction, RET, that pops the address from the stack and loads it into the PC. These instructions are used to create functions in AVR assembly. See Section 5.6 for more details on functions.

#### 5.3.3.2 Conditional Branches

Conditional branches will only modify the PC if the corresponding condition is meant. In AVR, the condition is determined by looking at the Status Register (SREG) bits. For example, the Branch Not Equal, BRNE, instruction will look at the Zero Flag (Z) of the SREG. If \( Z = 0 \), then the branch is taken, else the branch is not taken. At first this might not seem very intuitive, but in AVR, all the comparisons take place before the branch.

There are several things that can modify the SREG bits. Most arithmetic and logic instructions can modify all of the SREG bits. But what are more commonly used is the compare instructions, (CP, CPC, CPI, CPSE). The compare instructions will subtract the
two corresponding registers in order to modify the SREG. The result of this subtraction is not stored back to the first argument. With this in mind, take a look at BRNE again. If the values in two register are equal when they are subtracted, then the resulting value would be zero and then $Z = 1$. If they were not equal then $Z$ would be 0. Now when BRNE is called, the $Z$ bit can determine the condition. Section 5.5 shows several examples of how to use this process. The following table gives a nice quick summary of all conditional tests, the corresponding instruction, and what bits in SREG are manipulated to determine the condition.

### Table 7: Conditional Branch Summary

<table>
<thead>
<tr>
<th>Test</th>
<th>Boolean</th>
<th>Mnemonic</th>
<th>Complementary</th>
<th>Boolean</th>
<th>Mnemonic</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>$Rd &gt; Rr$</td>
<td>$Z \oplus (N \oplus V) = 0$</td>
<td>BRLT(^{(1)})</td>
<td>$Rd \leq Rr$</td>
<td>$Z \oplus (N \oplus V) = 1$</td>
<td>BRGE</td>
<td>Signed</td>
</tr>
<tr>
<td>$Rd \geq Rr$</td>
<td>$(N \oplus V) = 0$</td>
<td>BRGE</td>
<td>$Rd &lt; Rr$</td>
<td>$(N \oplus V) = 1$</td>
<td>BRLT</td>
<td>Signed</td>
</tr>
<tr>
<td>$Rd = Rr$</td>
<td>$Z = 1$</td>
<td>BREQ</td>
<td>$Rd \neq Rr$</td>
<td>$Z = 0$</td>
<td>BRNE</td>
<td>Signed</td>
</tr>
<tr>
<td>$Rd \leq Rr$</td>
<td>$Z \oplus (N \oplus V) = 1$</td>
<td>BRGE(^{(1)})</td>
<td>$Rd &gt; Rr$</td>
<td>$Z \oplus (N \oplus V) = 0$</td>
<td>BRLT</td>
<td>Signed</td>
</tr>
<tr>
<td>$Rd &lt; Rr$</td>
<td>$(N \oplus V) = 1$</td>
<td>BRLT</td>
<td>$Rd \geq Rr$</td>
<td>$(N \oplus V) = 0$</td>
<td>BRGE</td>
<td>Signed</td>
</tr>
<tr>
<td>$Rd &gt; Rr$</td>
<td>$C + Z = 0$</td>
<td>BRSH/BRCC</td>
<td>$Rd \leq Rr$</td>
<td>$C + Z = 1$</td>
<td>BRSH</td>
<td>Unsigned</td>
</tr>
<tr>
<td>$Rd = Rr$</td>
<td>$Z = 1$</td>
<td>BREQ</td>
<td>$Rd \neq Rr$</td>
<td>$Z = 0$</td>
<td>BRNE</td>
<td>Unsigned</td>
</tr>
<tr>
<td>$Rd \leq Rr$</td>
<td>$C + Z = 1$</td>
<td>BRSH(^{(1)})</td>
<td>$Rd &gt; Rr$</td>
<td>$C + Z = 0$</td>
<td>BRLO</td>
<td>Unsigned</td>
</tr>
<tr>
<td>$Rd &lt; Rr$</td>
<td>$C = 1$</td>
<td>BRLO/BRCS</td>
<td>$Rd \geq Rr$</td>
<td>$C = 0$</td>
<td>BRSH/BRCC</td>
<td>Unsigned</td>
</tr>
<tr>
<td>Carry</td>
<td>$C = 1$</td>
<td>BRCS</td>
<td>No carry</td>
<td>$C = 0$</td>
<td>BRCC</td>
<td>Simple</td>
</tr>
<tr>
<td>Negative</td>
<td>$N = 1$</td>
<td>BRMI</td>
<td>Positive</td>
<td>$N = 0$</td>
<td>BRPL</td>
<td>Simple</td>
</tr>
<tr>
<td>Overflow</td>
<td>$V = 1$</td>
<td>BRVS</td>
<td>No overflow</td>
<td>$V = 0$</td>
<td>BRVC</td>
<td>Simple</td>
</tr>
<tr>
<td>Zero</td>
<td>$Z = 1$</td>
<td>BREQ</td>
<td>Not zero</td>
<td>$Z = 0$</td>
<td>BRNE</td>
<td>Simple</td>
</tr>
</tbody>
</table>

Note: 1. Interchange $Rd$ and $Rr$ in the operation before the test, i.e., $CP Rd,Rr \rightarrow CP Rr,Rd$

Additionally, conditional branches include the skip instructions (SBRC, SBRS, SBIC, SBIS). These instructions will skip the next instruction if the condition is meant. These can be very useful in determining whether or not to call a function. Note that the skip instructions are limited to only bit testing on registers or specific areas in IO Memory.

### 5.3.4 Data Transfer Instructions

The majority of instructions in any assembly language program are data transfer instructions. These instructions essentially move data from one area in memory to another. As easy as this concept seems, it can quickly become very complicated and overwhelming. For example, the AVR Instructions Set supports five different addressing modes: Immediate, Direct, Indirect, Indirect with Pre-Decrement, Indirect with Post-Increment, and Indirect with Displacement. But each of these modes can be broken down into comprehensible sections.

#### 5.3.4.1 Immediate Addressing

Immediate addressing is simply a way to move a constant value into a register. Only one instruction supports immediate addressing, LDI. Also note that this instruction will only work on the upper 16 General Purpose Registers, R16 – R31. The following is an example of when LDI would be used. Suppose there was a loop that needed to be looped
16 times. Well, a counter register could be loaded with the value 16 and then decremented after each loop. When the register reached zero, then the program will exit from the loop. Since the value 16 is a constant, we can load into the counter register by immediate addressing. The following code demonstrates this example.

```assembly
.def counter = r22 ; Create a register variable
ldi counter, 16 ; Load the immediate value 16 in counter
Loop: breq Exit ; If zero, exit loop
  adc r0, r1 ; Do something
  dec counter ; Decrement the counter
  rjmp Loop ; Redo the loop
Exit: inc r0 ; Continue on with program
```

### 5.3.4.2 Direct Addressing

Direct addressing is the simplest way of moving data from one area of memory to another. Direct addressing requires only the address to access the data. But it is limited to the use of the register file. For example, if you wanted to move a byte of data from one area in Data Memory to another area in Data Memory, you must first load the data a register and then store the data into the other area of memory. In general, every data manipulation instruction, except LDI, comes in a Load and Store pair. For Direct Addressing modes, the instruction pairs are LDS/STS and IN/OUT.

The point of having multiple instruction pairs is to access different areas of memory.

- LDS/STS – Move data in and out of the entire range of the SRAM Data Memory
- IN/OUT – Move data in and out of the IO Memory or $0020 - $005F of the SRAM Data Memory. IN/OUT takes less instruction cycles than LDS/STS does.

The following is an example loop that continually increments the data value at a particular address.

```assembly
.equ addr = $14D0 ; Address of data to be manipulated
Loop: lds r0, addr ; Load data to R0 from memory
  inc r0 ; Increment R0
  sts addr, r0 ; Store data back to memory
  rjmp Loop ; Jump back to loop
```

### 5.3.5 Bit and Bit-test Instructions

Bit and Bit-test Instructions are instructions that manipulate or test the individual bits within an 8-bit register. There are three types of Bit and Bit-testing instructions; Shift and Rotate, Bit Manipulation, and SREG Manipulation.

#### 5.3.5.1 Shift and Rotate

Shifting a register literally means shifting every bit one spot to either the left or the right. The AVR Instruction set specifies register shifts as two types of instructions, shifts and rotates. Shifting will just shift the last bit out to carry bit and shift in a 0 to the first bit. Rotating will shift out the last bit to the carry bit and shift in the carry bit to the first bit. Therefore rotating a register will not lose any bit data while shifting a register will loose
the last bit. The instruction mnemonics are LSL, LSR, ROL, and ROR for Logical Shift Left, Logical Shift Right, Rotate Left Through Carry, and Rotate Right Through Carry respectively.

There are also some special Shifting Instructions, Arithmetic Shift Right (ASR) and Swap Nibbles (SWAP). Arithmetic Shift Right behaves like a Logical Shift Right except it does not shift out to the carry bit. Instead, ASR, will right shift anywhere from 1 to 7 spaces. Swap Nibbles will swap the upper and lower 4-bits with each other.

5.3.5.2 Bit Manipulation

Bit Manipulation Instructions allow the programmer to manipulate individual bits within a register by setting, or making the value 1, and clearing, or making the value 0, the individual bits. There are three instruction pairs to manipulate the SREG, an I/O Register, or a General Purpose Register through the T flag in the SREG. BSET and BCLR will set and clear respectively any bit within the SREG register. SBI and CBI will set and clear any bit in any I/O register. BST will store any bit in any General Purpose Register to the T flag in the SREG and BLD will load the value of the T flag in the SREG to any bit in any General Purpose Register.

5.3.5.3 SREG Manipulation

Although the instructions SBI and CBI will allow a programmer to set and clear any bit in the SREG, there are additional instructions that will set and clear specific bits within the SREG. This is useful for when the programmer does not want to keep track of which bit in the SREG is for what. The following table shows the mnemonics for each set and clear instruction pair are in the table below.

<table>
<thead>
<tr>
<th>Bit</th>
<th>Bit Name</th>
<th>Set Bit</th>
<th>Clear Bit</th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
<td>Carry Bit</td>
<td>SEC</td>
<td>CLC</td>
</tr>
<tr>
<td>N</td>
<td>Negative Flag</td>
<td>SEN</td>
<td>CLN</td>
</tr>
<tr>
<td>Z</td>
<td>Zero Flag</td>
<td>SEZ</td>
<td>CLZ</td>
</tr>
<tr>
<td>I</td>
<td>Global Interrupt Flag</td>
<td>SEI</td>
<td>CLI</td>
</tr>
<tr>
<td>S</td>
<td>Signed Test Flag</td>
<td>SES</td>
<td>CLS</td>
</tr>
<tr>
<td>V</td>
<td>Two’s Complement OVF Flag</td>
<td>SEV</td>
<td>CLV</td>
</tr>
<tr>
<td>T</td>
<td>T Flag</td>
<td>SET</td>
<td>CLT</td>
</tr>
<tr>
<td>H</td>
<td>Half Carry Flag</td>
<td>SEH</td>
<td>CLH</td>
</tr>
</tbody>
</table>
5.4 Coding Techniques

This section contains general hints and tips to produce well-structured code that can be easily debugged and save a lot of time and headaches.

5.4.1 Structure

It is important to create and maintain a consistent code structure throughout the program. Assembly Language in general can be greatly confusing; a well-structured program will ease this confusion and make the program very readable to yourself and other people. Spending several hours trying to find a specific problem area in a piece of code can become quite frustrating.

So what does a well-structured program look like? Structure includes everything that is typed in the program, where certain parts of the program are located, how an instruction looks within a line, etc. There are several ways to write out the code on the ‘paper’, but the most important part is to be consistent. If you start writing your code in one fashion, maintain that fashion throughout the remainder of the program. Varying between different ‘styles’ can be quite confusing and make the code unreadable.

The one style that I recommend is using the four-column method. If this style is used consistently throughout the program, the program should look like four columns. A column is usually separated with one or two tabs depending on how long the data strings are. In general, the following table describes what goes into each column, the tab lengths and exception rules.

<table>
<thead>
<tr>
<th>Column</th>
<th>Tab Length</th>
<th>Includes</th>
<th>Comments</th>
</tr>
</thead>
</table>
| 1      | 1          | Pre-compiler Directives, Labels | • If a label is longer than one tab length, then the instruction mnemonic goes on the next line.  
• No instructions must be placed on the same line as a pre-compiler directive. |
| 2      | 1          | Directive Parameters, Instruction Mnemonic | • It is common for Directive Parameters to exceed one tab length. |
| 3      | 2          | Instruction Parameters | • If Instruction Parameters exceed two tab lengths, then place the comment on the previous line. |
The following is an example of well-formatted code using the rules from Table 9: Line Formatting Rules.

```
; Title: XOR Block of Data
; Author: David Zier
; Date: March 16, 2003

.include "ml28def.inc"  ; Include definition file
.def tmp = r15  ; Temporary Register
.def xor = r6   ; XOR Register
.equ addr1 = $1500  ; Beginning Address
.equ addr2 = $2000  ; Ending Address

; This code segment will XOR all the bytes of data between the two address ranges.
.org $0000  ; Set the program starting address

INIT: ldi XL, low(addr1) ; Load low byte of start address in X
     ldi XH, high(addr1) ; Load high byte of start address in X

FETCH:
     ldi tmp, X+  ; Load data from address into tmp
     eor xor, tmp ; XOR tmp with xor register, store in xor
     cpi XL, low(addr2) ; Compare high byte of X with End Address
     brne FETCH ; If low byte is not equal, then get next
     cpi XH, high(addr2) ; Compare low byte of X with End Address
     brne FETCH ; If high byte is not equal then get next

DONE: rjmp DONE ; Infinite done loop
```

The next part to proper code structure is code placement. Certain sections of code should be placed in certain areas. This alleviates confusion and allows the contents to be ordered and navigable. The following table illustrates the order in which certain code segments are to be placed.
### Table 10: Code Structure

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header Comments</td>
<td>Title, Author, Date, and Description</td>
</tr>
<tr>
<td>Definition Includes</td>
<td>Specific Device Definition Includes, i.e. “m128def.inc”</td>
</tr>
<tr>
<td>Register Renaming</td>
<td>Register renaming and variable creation, i.e. .def tmp = r0</td>
</tr>
<tr>
<td>Constant Declaration</td>
<td>Constant declarations and creation, i.e. .equ addr = $2000</td>
</tr>
<tr>
<td>Interrupt Vectors</td>
<td>See Section 4.2 Interrupt Vectors</td>
</tr>
<tr>
<td>Initialization Code</td>
<td>Any initialization code goes here</td>
</tr>
<tr>
<td>Main Code</td>
<td>The heart of the program.</td>
</tr>
<tr>
<td>Subroutines</td>
<td>Any subroutine that is created follows the main code.</td>
</tr>
<tr>
<td>ISRs</td>
<td>Any Interrupt Subroutines will go here.</td>
</tr>
<tr>
<td>Data</td>
<td>Any hard coded data is best placed here, i.e. .DB “hello”</td>
</tr>
<tr>
<td>Additional Code Includes</td>
<td>Finally, if there is any additional source code includes, will go last.</td>
</tr>
</tbody>
</table>

By following these simple structure rules, the code will be more readable and understandable.

#### 5.4.2 Register Naming

Register naming is an important part to any program. It alleviates confusion and makes the code more readable, thus it will be easier to debug. The main purpose to renaming a register is to assign a register as a specific variable type. For example, if I wanting a temporary register that I would use through out the program to hold one-shot data, I would name the register “tmp”. If I was writing a program that executed a complex arithmetic routine, I might want a variable to store the result, so I name a register “res”.

The reason you would rename a register is to alleviate confusion. If I just used the regular register names ( r0, r1, r2, etc. ), I could easily get confused as to what each register was used for. Was r0 the register to hold the result or was r13? As the program grows more complex, this can easily be the case.

Register names should be short but descriptive and unique. Short names fit well into the four-column formatting scheme. Names should be no longer the six letters, but on average, be 3 letters in length. For example, “tmp” for temporary, “res” for result, “addrl” for address low byte, or “cnt” for count. Make the names as descriptive as
possible. Using a register named “tmp” that always holds the value to be compared is not good; a better name might be “cmp” for compare. And finally, the name must be unique. Don’t name several registers “tmp1”, “tmp2”, and “tmp3”. This is no better than using r1, r2, and r3. In fact it is worse, because you have to type more letters. If there is ever situations where multiple temporary register are to be used, make them unique. An example might be “otmp” and “itmp” for outer loop temporary and inner loop temporary respectively.

Proper register naming will make coding easier, so it is a good idea to get in the habit. Also, bad register naming can make code much more difficult to work with. In general, a segment of code that using register renaming can be easily understandable, even without the comments.

5.4.3 Constants and Addressing

Like register renaming, constant names should be short, descriptive, and unique. So when does one use a constant? If you ever find your self repeatedly using the same constant value over and over again, then a constant is needed. Constants are beneficial in two ways; one, they make the code more readable and thus more easy to debug, and two, allow you change the behavior of the program by adjusting the constant numbers in the beginning of the code.

If there were no constants, a programmer might have to search through the entire code to see particular value was and change, maybe even multiple times. With constants, this requires only one edit and no searching each time the programmer wants to change a value.

Common uses of constants are with set addresses. One thing to note is that addresses are 16-bits and registers are 8-bits. This means that you must deal with addresses as low and high bytes. There are several things to be concerned with here. First, when comparing addresses always compare both the low and the high bytes, even if the high byte doesn’t change. It is very possible, that by the time the program is finished, the high byte might change and since it was not compared, the program does not function properly. Next, the programmer would need to consider how to use and access a 16-bit constant. The following code is one example of how to access the address $23D4.

```assembly
.equ addrl = $D4   ; Low byte of address
.equ addrh = $23   ; High byte of address
...  
ldi XL, addrl  ; Load low byte of address
ldi XH, addrh  ; Load high byte of address
```

This will works, but it is not a good method for accessing the low and high bytes. Below is a better and much preferred method.

```assembly
.equ addr = $23D4  ; The address
...  
ldi XL, low(addr) ; The low byte of the address
ldi XH, high(addr) ; The high byte of the address
```
This is better because now you can see the address in its entirety. The previous method split the address into two separate byte constants, which can become confusing when changing the address. For example, what if I wanted to have another address constant and I put it as high then low. I might get confused and enter the wrong byte of the address because it is not consistent with the previous method. By putting the entire address, you can easily read or edit the address. Additionally, inserting another address will not be confusing since it is consistent. We later use the high() and low() macros to access the high and low bytes.

It is a good idea to name every constant that you use within your code. It is quick, easy, and saves you a lot of time when coding and debugging. It is definitely more beneficial for you to use constants than to not.

5.4.4 ATMega128 Definition File
A definition file is a file that contains addresses and values for common I/O registers and special registers within a specific chipset. For example, every ATMEL AVR chipset contains an SREG, but not every chipset has the SREG in the same memory location. This is where the definition file comes in. Just write your code with the common name for the I/O register such as SREG or SPH, and then include the definition file in the beginning of you code. This does two things, first, the programmer doesn’t have to look up or memorize the address for each to the I/O register or chip specific registers and second, the same code can be used for different chipset by just including the proper definition file.

Since this document mostly concentrates on the ATMega128, we use the definition file so that we don’t have to look up the address for specific I/O registers. The definition file is for the ATMega128 is m128def.inc. It contains a lot of .equ and a few .def expressions. The file also contains useful information such as the last address in SRAM (RAMEND). It is included with AVR Studio4 when you download and install the program.

5.5 Flow of Control
This section will contain several examples of C-like flow of control expressions and how to code the same thing in AVR Assembly. These flow of control examples will show the proper way to use a branch instruction and more importantly, what a branch instruction is used for.

5.5.1 IF Statement
This is probably the most simplest and straightforward control statement in program. In C, the IF statement is commonly seen as:

```c
if (expr)
    statement
```

If `expr` is nonzero (true), then `statement` is executed; otherwise `statement` is skipped, and control passes to the next statement. This is true for assembly as well. For example, the following C-code.
if (n >= 3)
{
    expr++;
    n = expr;
}

Here is the equivalent version in assembly.

```
.def n = r0
.def expr = r1
.equ cmp = 3
...
    cpi n, cmp     ; Compare value
IF:  brsh EXEC   ; If n >= 3 then branch to NEXT
    rjmp NEXT    ; Jump to NEXT since expression is false
EXEC: inc expr  ; increment expr
    mov n, expr ; Set n = expr
NEXT: ...       ; continue on with code
```

Although this code behaves like the C-code, it is not optimal. By simply using the complementary Boolean Expression, you can save space and speed up the program.

```
.def n = r0
.def expr = r1
.equ cmp = 3
...
    cpi n, cmp     ; Compare value
IF:  brlo NEXT   ; If n >= 3 is false then skip code
    inc expr     ; increment expr
    mov n, expr  ; Set n = expr
NEXT: ...       ; Continue on with code
```

This statement behaves exactly the same but uses one less branch statement and one less line of code. And more importantly, is easier to read and understand.

### 5.5.2 IF-ELSE Statement

This is very similar to the IF statement, except it has an additional unconditional else statement. This is not too hard to implement. Here is an example C-Code.

```
if (n == 5)
    expr++;
else
    n = expr;
```

And here is the equivalent code in AVR Assembly.
AVR Studio 4 and ATmega128: A Beginner’s Guide

```
.def n = r0
.def expr = r1
.equ cmp = 5
...
    cpi n, cmp    ; Compare value
    breq IF       ; Branch to IF if the n == 3
    rjmp ELSE     ; Branch to ELSE if the expression is false
IF:    inc expr  ; Increment expression
    rjmp NEXT    ; Goto NEXT
ELSE:  mov n, expr ; Set n = expr
NEXT:  ...    ; Continue on with code
```

We can make this more efficient if we use the complimentary Boolean expression.

```
.def n = r0
.def expr = r1
.equ cmp = 5
...
    cpi n, cmp    ; Compare value
    IF: brne ELSE  ; Goto ELSE statement since expression is false
      inc expr    ; Execute the IF statement
      rjmp NEXT    ; Continue on with code
ELSE:  mov n, expr ; Execute the ELSE statement
NEXT:  ...    ; Continue on with code
```

Again, this code has one less branch statement and one less instruction. Although this
does not seem like much now, but if this were nested within a loop that looped 100 times,
then it is essentially 100 less instructions to be executed.

### 5.5.3 IF-ELSIF-ELSE Statement

This is simply a nested mix of the IF and IF-ELSE statements. A C example would be:

```
if (n < 3)
    expr++;
else if (n == 5)
    n = expr;
else
    n++;
```

Here is how to logically convert it into assembly.

```
.def n = r0
.def expr = r1
.equ val1 = 3
.equ val2 = 5
...
    cpi n, val1    ; Compare n with val1
    brlo IF        ; If n < 3, then execute if
    rjmp ELIF      ; Goto ELSEIF Expression
IF:    inc expr  ; Execute if statement
    rjmp NEXT     ; Goto Next
ELIF:  cpi n, val2 ; Compare n with val2
    breq ELIE     ; If n == 5, then execute ELSEIF statement
```

TekBots™  Oregon State University  Page 42 of 53
This seems a little complicated and confusing. By changing the Boolean expressions, the code can be optimized and less confusing.

```
.def n = r0
.def expr = r1
.equ val1 = 3
.equ val2 = 5
...
cpi n, val1 ; Compare n with val1
IF: brsh ELIF ; If is not n < 3, then goto ELSEIF expression
    inc expr ; Execute if statement
    jmp NEXT ; Goto Next
ELIF: cpi n, val2 ; Compare n with val2
    brne ELSE ; If is not n == 5, then goto ELSE expression
    mov n, expr ; Execute ELSEIF statement
    jmp NEXT ; Goto Next
ELSE: inc n ; Execute ELSE statement
NEXT: ... ; Continue on with code
```

This optimized code has two less instructions and two less branches. In addition, it is easier to read and understand.

### 5.5.4 WHILE Statement

The WHILE statement is commonly used to create repetitive loops. In fact, it is common to use an infinite while loop to end a program. Consider a construction of the form:

```
while (expr)
    statement
next statement
```

First `expr` is evaluated, if it is nonzero (`true`), the `statement` is executed, and control is passed back to the beginning of the WHILE loop. The effect of this is that the body of the WHILE loop, namely the `statement`, is executed repeatedly until `expr` is zero (`false`). At that point control passes to `next statement`. An example is:

```
while (n < 10) {
    sum += n;
    n++;
}
```

In assembly, WHILE loops can be created pretty easily. Here is the equivalent assembly code:

```
.def n = r0
.def sum = r3
.equ limit = 10
```
WHIL: cpi n, limit ; Compare n with limit
   brlo WHEX ; When n < limit, goto WHEX
   rjmp NEXT ; Condition is not meet, continue with program
WHEX: add sum, n ; sum += n
      inc n ; n++
   rjmp WHIL ; Go back to beginning of WHILE loop
NEXT: ... ; Continue on with code

This code can also be optimized as follows:

.def n = r0
.def sum = r3
.equ limit = 10

WHIL: cpi n, limit ; Compare n with limit
   brsh NEXT ; When not n < limit, goto NEXT
   add sum, n ; sum += n
   inc n ; n++
   rjmp WHIL ; Go back to beginning of WHILE loop
NEXT: ... ; Continue on with code

By converting the BRLO to BRSH, we were able to remove one of the branch instructions and make the code look more like a WHILE loop.

5.5.5 DO Statement
The DO statement can be considered a variant of the WHILE statement. Instead of making its test at the top of the loop, it makes it at the bottom. The following is an example:

    do {
       sum += n;
       n--;
    } while (n > 0);

The assembly code for the DO statement is also very similar to the WHILE statement.

.do n = r0
.do sum = r3
.equ limit = 0

DO: add sum, n ; sum += n
   dec n ; n++
   cpi n, limit ; compare n to limit
   cpi n, limit ; compare n to limit
   brne DO ; since n is unsigned, brne is same expr
NEXT: ... ; Continue on with code

As you can see, a DO statement provides better performance over the optimized WHILE statement. But even this function can be optimized.

.do n = r0
.do sum = r3
Although the optimization does not affect the performance of the DO statement in general, it did for this case. Since DEC is called before the BRNE instruction, the CPI instruction is not needed. The CPI instruction forces the specific bits in the SREG to occur that are needed by the branching instructions. In this case, the DEC instruction will work as well. For example, when the DEC instruction decrements the \( n \) value and \( n \) becomes zero, then the Zero Flag in the SREG is set. This is the only bit that is checked by the BRNE command. Thus we can completely remove the CPI instruction.

### 5.5.6 FOR Statement

The FOR statement, like the WHILE statement, is used to execute code iteratively. We can explain its action in terms of the WHILE statement. The construction

```c
for (expr1; expr2; expr3)
    statement
next statement
```

is semantically equivalent to

```c
expr1;
while (expr2) {
    statement
    expr3;
}
next statement
```

provided that \( expr2 \) is present. FOR loops are commonly used to run through a set of data. For example, the following is some code that iterates 10 times.

```c
for (n = 0; n < 10; n++)
    sum += n;
```

The following assembly is the equivalent of the C code.

```assembly
.def n = r0
.def sum = r3
.equ max = 10
...
ldi n, 0  ; Initialize n to 0
FOR:  cpi n, max ; Compare n to max value
     brlo EXEC  ; If n < max, the goto EXEC
     rjmp NEXT  ; Statement is false, break out of FOR loop
EXEC: add sum, n  ; sum += n
     inc n  ; decrement n
     rjmp FOR  ; goto the start of FOR loop
```
NEXT: ... ; rest of code

There are several things to do to optimize this code, first, use a DO loop instead of a WHILE loop. Next use the complemented form of the expression. And lastly, initialize the variable \( n \) to max and decrement it. This will allow us to use the SREG technique from Section 5.5.5.

\[
\text{.def } n = r0 \\
\text{.def sum = r3} \\
\text{.equ max = 10} \\
\ldi n, max \quad \text{; Initialize } n \text{ to max} \\
\ldi \text{ FOR: add sum, } n \quad \text{; sum += } n \\
\text{ dec n \quad \text{; decrement } n} \\
\text{ brne FOR \quad \text{; repeat loop if } n \text{ does not equal 0}} \\
\text{NEXT: ... \quad \text{; rest of code}}
\]

This removed seven instructions and two branches. In addition, the code is simpler and easier to read. And more importantly, it has the same functionality as the C code. This is also a good example of why to name constants. If we wanted the FOR loop to loop 25 times, then all we would have to do is change the max constant from 10 to 25. No sweat!

### 5.5.7 SWITCH Statement

The SWITCH statement is a multiway conditional statement generalizing the IF-ELSE statement. The following is a typical example of a SWITCH statement:

```c
switch (val) {
    case 1:
        a_cnt++;
        break;
    case 2:
    case 3:
        b_cnt++;
        break;
    default:
        c_cnt++;
}
```

The case statement is probably the most complicated to write in assembly. Here is the logical form for the above C code example.

\[
\text{.def val = r0} \\
\text{.def a_cnt = r5} \\
\text{.def b_cnt = r6} \\
\text{.def c_cnt = r7} \\
\ldi \text{ SWITCH: \quad \text{; The beginning of the SWITCH statement}} \\
\text{ cpi val, 1 \quad \text{; Compare } val \text{ to } 1} \\
\text{ breq S_1 \quad \text{; Branch to } S_1 \text{ if } val == 1} \\
\text{ cpi val, 2 \quad \text{; Compare } val \text{ to } 2} \\
\text{ breq S_3 \quad \text{; Branch to } S_3 \text{ if } val == 2} \\
\text{ cpi val, 3 \quad \text{; Compare } val \text{ to } 3}
\]
breq S_3 ; Branch to S_3 if val == 3
inc c_cnt ; Execute Default
rjmp NEXT ; Break out of switch
S_1: inc a_cnt ; Execute case 1
rjmp NEXT ; Break out of switch
S_3: inc b_cnt ; Execute case 2
NEXT: ... ; The rest of the code

This is the general idea, although some might even nest the execution within condition expressions to make it more logically correct. Yet, using the complementary Boolean expression can optimize this code segment. (Do you a similar pattern yet!)

.def val = r0
.def a_cnt = r5
.def b_cnt = r6
.def c_cnt = r7

SWITCH: ; The beginning of the SWITCH statement
S_1: cpi val, 1 ; Compare val to 1
brne S_2 ; Branch to S_2 if val != 1
inc a_cnt ; Execute case 1
rjmp NEXT ; Break out of switch
S_2: cpi val, 2 ; Compare val to 2
brne S_3 ; Branch to S_3 if val != 2
inc b_cnt ; Execute case 2
rjmp NEXT ; Break out of switch
S_3: cpi val, 3 ; Compare val to 3
brne DFLT ; Branch to DFLT if val != 3
inc b_cnt ; Execute case 3
rjmp NEXT ; Break out of switch
DFLT: inc c_cnt ; Execute default
NEXT: ... ; The rest of the code

Believe it or not, this code actually has better optimization than the former. In the former, any given case statement will have to go through two branches before it is executed. In the optimized version, it will only have to go through one branch. If you take a look at the worse case scenario, there are fewer jumps to get to the default statement as well. Therefore this is the optimal code, even though there are more instructions.

5.6 Functions and Subroutines
AVR Assembly language has the ability create and execute functions and subroutines. By simply using a subroutine or a function, a programmer can drastically reduce the size and complexity of the code. Because of the importance, this topic is given its own subsection. This section will cover the general topics of functions and subroutines, included how to create one, when to create one, and how to use one.

5.6.1 Definitions
A function or a subroutine can generally be thought as “reusable code”. Reusable code is any segment of code that can be used over and over through out the program without
duplicity or two copies of the same code. You can think of functions and subroutines as they are implemented in a C program. The function is created outside of the main program and then is later called within the main program, sometimes in multiple areas.

Reusable code within an assembly program can be thought of as either a function or a subroutine. Both are very similar in terms of how they are implemented, but have subtle differences.

A subroutine is a reusable piece of code that requires no input from the main program. Generally, the state of the program is saved upon entering the subroutine and is restored before leaving the subroutine. This is perfect for when servicing interrupts.

A function, on the other hand, is involved within the main code and requires some interaction. This usually means that some registers or other memory has to be initialized before the function is called. In addition, a function will most likely alter the state of the program.

In general, a subroutine must not alter the state of a running program and no care must be taken to ensure the proper operation of a subroutine. For a function, the main program must initialize data for the function to work properly and must be able to handle any changes caused by the function.

5.6.2 Operational Overview

A subroutine or function is called via the CALL, RCALL, ICALL, or EICALL instructions and is matched with an RET instruction to return to the instruction address after the call. The function or subroutine is preceded by a label that signifies the name of function or subroutine. When a CALL instruction is implement, the processor first pushes the address of the next instruction after the CALL instruction onto the stack. This is important to realize since it means that the stack must be initialized before functions or subroutines can be used. The CALL instruction will then jump to the address specified by label used as the parameter. The next instruction to be executed will then be the first instruction with the subroutine or function. Upon exiting the subroutine or function, the return instruction, RET, must be called. The RET instruction will then pop the address of the next instruction after the CALL instruction from the stack and load into the PC. Thus the next instruction to be executed is the instruction after the CALL instruction.

It is important to keep track of what is pushed and popped on the stack. If within a subroutine or function, data is not popped correctly, the RET instruction can pop the wrong data values for the address and thus the program will not function correctly. Additionally, never exit a subroutine or function via another jump instruction other than RET. Doing so will cause the data in the stack to never be popped and thus the stack will become out of sink.

So when does a programmer decide to create a subroutine or function? This can often be a tough call and can get really complicated. The general rule of thumb is that a subroutine or function is needed when the programmer finds that the same segment of
code is being written in several places within the program. This can be very troublesome since an error within the code segment result in several hours of work trying to fix every instance of the code segment. On the other hand, if the program were to use a function or subroutine, the fixing the code is easy since there is only one instance and it is in a common location.

5.6.3 Implementation

In the last section, we briefly talked about how a function or a subroutine works. This section will give detailed explanations on how to implement both the function and the subroutine.

5.6.3.1 Setup

The first thing to do for any function and subroutine is to initialize the stack. This can be done in four lines of code at the beginning of the program. Optimally, the stack should be initialized for any program. Here is the code:

```
.include "m128def.inc"

INIT:     ; Initial the stack pointer
    ldi r16, low(RAMEND) ; Load the lo byte of the ram’s end addr
    out SPL, r16  ; Set the Stack Pointer Low register
    ldi r16, high(RAMEND) ; Load the hi byte of the ram’s end addr
    out SPH, r16  ; Set the Stack Pointer High register
```

After this point, any function or subroutine will correctly in regards to the stack.

5.6.3.2 Subroutine Implementation

The subroutine does not require any outside influence for its performance. Therefore it is a good idea to save the state of the program before executing the subroutine. This means that certain registers must be pushed to the stack in the beginning of the subroutine and popped just before the subroutine ends. It is important to remember to pop registers in reverse order from which they where pushed. These registers include the SREG (essentially the state of the program) and any general purpose registers that are used throughout subroutine.

A good example of a routine is a wait loop that will wait for a specific amount of time. For our case, we will want the wait subroutine to wait for 1000 cycles (not including the subroutine overhead cycles.)

```
.def ocnt = r16   ; Outer loop count variable
.def icnt = r17   ; Inner loop count variable

WAIT:     ; Wait subroutine
    push icnt   ; Save icnt register
    push ocnt   ; Save ocnt register
    in ocnt, SREG  ; Get the SREG value
    push ocnt   ; Save the value of the SREG
    ldi ocnt, 55  ; Loop outer loop 55 times

WTL1: ldi icnt, 5  ; Loop inner loop 5 times

WTL2: dec icnt   ; Decrement inner loop counter
```
brne WTL2 ; Continue through inner loop
dec ocnt ; Decrement outer loop counter
brne WTL1 ; Continue through outer loop
ldi ocnt, 3 ; This next loop just uses 9 cycles

WTL3: dec ocnt ; that is need for the 1000 cycles
brne WTL3 ; Repeat last loop 3 times
nop ; We still come up 1 cycle short
pop ocnt ; Get the SREG value
out SREG, ocnt ; Restore the value of the SREG
pop ocnt ; Restore ocnt register
pop icnt ; Restore icnt register
ret ; Return from subroutine

We are going to stray off topic for a second to discuss this code. From the time first LDI instruction is called to the last NOP, there are exactly 1000 cycles of execution. To calculate this, you must take into consideration the number of cycles it takes to execute each instruction. With the exception of the branches, every instruction takes one cycle. The branches take 1 cycle if false and 2 cycles if true. With this in mind, the main loop follows the equation \((3\times icnt + 3)\times ocnt\). The optimal values for \(icnt\) and \(ocnt\) are 5 and 55 respectively. This yields the total number of cycles for the main to be 990 cycles. This is unfortunately 10 cycles short of our goal. We could just shove 10 consecutive NOPs at the end, but instead opted for a second small loop. This second loop follows the equation \(3\times ocnt\) and with a value of \(ocnt\) being 3 yields 9 cycles. Therefore, with the addition of a single NOP instruction, our total number of cycles is 1000 cycles.

Now back to the topic of subroutines. As you can see in the example code, the very first thing we do is push the SREG to the stack. Additionally, we also push the registers \(icnt\) and \(ocnt\) since they are used within the subroutine. We then execute the main subroutine code. This followed up by popping the data from the stack in the reverse order that it is pushed. And finally, we leave the subroutine with the RET instruction. Another item to notice is that PUSH and POP only deal with the general-purpose registers. Therefore, if we wanted to push an I/O Register, such as the SREG, we must first load it into a general-purpose register. Since we were already using the \(ocnt\) register within the subroutine, we used it to temporarily hold the SREG value. We made sure the \(ocnt\) register was first pushed to the stack so that we didn’t loose any data that might have been there.

So now how does a programmer use a subroutine once it has been created? Well, this is easier than it sounds. Since a label precedes the subroutine, we can just make a call to the label with one of the CALL instructions.

MAIN: ldi r16, 4 ; Set r16 to 4
LOOP: rcall WAIT ; Call our WAIT routine
dec r16 ; Decrement r16
brne LOOP ; Call the wait statement 4 times
... rcall WAIT ; Additional code
... DONE: rjmp DONE ; Program complete
As you can see, this program will call the WAIT routine in several places. Now if the routine did not exist, then we would have to write all that code twice in several places. While this is not hard with modern technologies such as cut and paste, the might still initially be incorrect. This means that we now have to search through the rest of the code and this can quickly become a headache. By now, you should be able to understand how subroutines can make your programming experience better.

5.6.3.3 Function Implementation

A function is a bit different from a subroutine in the fact that it alters the state of the program. Unlike the subroutine, the function will most likely need to be initialized prior to the function call. This is how to create input to a function. Also the function will most likely modify some registers to provide output. With the exceptions of the input and output, a function behaves just like a routine. Any registers that used within a function but do not correspond to any input or output, must still be pushed and popped from the stack.

We will use a common example of a function that takes two 8-bit numbers and multiplies them together. Since an 8-bit multiplication results in a 16-bit number, the result will be stored in the same registers that were used for the input. The two input registers are the multiplier (mplr) and the multiplicand (mplc). The high byte of the result will be stored in mplr and the low byte will be stored in mplc. The basic multiplication algorithm will be to repeatedly add the multiplicand to itself for the amount specified in the multiplicand. So here is the function.

```
.def mplr = r18   ; The multiplier
.def mplc = r19   ; The multiplicand
.def resh = r1    ; The high byte of the result
.def resl = r2    ; The low byte of the result
.def zero = r0    ; Zero register that always contains 0

MUL:     ; The multiplication function
    push resh   ; Save the state of resh
    push resl   ; Save the state of resl
    push zero   ; Save the zero register
    clr zero   ; Enforce the 0 in the zero register
    clr resh   ; Clear the result high byte
    clr resl   ; Clear the result low byte
    cpi mplr, 0  ; Initially check mplr for 0
    breq EXIT   ; Check for end condition
    ADD: add resl, mplc  ; Add multiplicand to result
        adc resh, zero ; This just add the carry bit, if any
        dec mplr ; Decrement mplr
        brne ADD ; Repeat loop if mplr is not 0
    EXIT: mov mplr, resh ; Move high byte of result to mplr
        mov mplc, resl ; Move low byte of result to mplc
        pop zero ; Restore zero register
        pop resl ; Restore resl register
        pop resh ; Restore resh register
        ret ; Return from function
```
As you can see, the general structure and layout is very similar to a subroutine. The only difference is that we did not push and pop the registers mplr and mplc, since they are used for input and output. You will also note the SREG was not saved. Sometimes, a function will want to return the value of the SREG and therefore it is not necessarily vital to save it.

Now we will see how to utilize a function. The process is very similar to subroutine except that the input values need to be initialized before the function is called. It is also important to note that register renaming for the functions input and outputs should be done at the beginning of the program with the programs renamed registers. Like the subroutine, any register that is used internally can be renamed before the instance of the function. So here is an example of how to use the function we created in the above example.

```assembly
.def mplr = r18
.def mplc = r19

INIT: ldi r16, high(RAMEND) ; Initialize the stack pointer high byte
    out SPH, r16
    ldi r16, low(RAMEND) ; Initialize the stack pointer low byte
    out SPL, r16

MAIN: ... ; Other code in the main program
    ldi mplr, 25 ; Load 25 into multiplier
    ldi mplc, 93 ; Load 93 into multiplicand
    rcall MUL ; Multiply 93 * 25
    st X+, mplr ; Do something with the result
    st X, mplc ; by storing it into memory
    ... ; Additional Code
    mov mplr, r5 ; Setup another multiplication function
    mov mplc, r8 ; with the registers r5 and r8
    rcall MUL ; Multiply r8 * r5
    mov r0, mplr ; Do something with the result
    mov r1, mplc ; by storing the result into r0:r1
    ... ; More code
DONE: rjmp DONE ; Program complete
```

As you can see, we initialize the function by storing the value we want to multiply into the mplr and mplc. We then call the multiplication function, MUL. And finally we handle the results. What values you want to multiply and what to do with the result depends on the program. By now, you should have a good understanding as how to create and use a function.
6 References


